Introducing Quick Scripts

Quick Scripts offer an easy way to automate tedious tasks such as
entering repetitive information into an order entry form, entering your user
name and password into a login screen, and uploading a report to the
server at a certain time every day. While you can use macros, which are
statements based on the Hummingbird Basic programming language, to
accomplish basically the same functions as Quick Scripts, you do not
require programming knowledge to work with Quick Scripts.

Quick Script Editor is a graphical development environment in which you
can create, modify, and run HostExplorer Quick Scripts (.qgs3, .gs5, and
.qsv) and FTP Quick Scripts (. qsf).

Related Topics

Working with HostExplorer Quick Scripts
Working with FTP Quick Scripts
Creating Quick Scripts




Launching Quick Script Editor

Quick Script Editor, which lets you work with either HostExplorer or FTP
Quick Scripts, can be launched in various ways. The menus and toolbars
vary depending on what type of script you are creating and/or modifying.

Note: Quick Scripts are emulation-specific. For example, a VT Quick Script functions properly only
when launched from a VT session. To switch to a different Quick Script type, click New on the
File menu and specify a different type.

To launch Quick Script Editor from the program shortcut:

Click the Windows Start menu, navigate to the Hummingbird
Connectivity/Accessories program group, and then click Quick Script
Editor.

To launch Quick Script Editor from HostExplorer:

Tip: For more information on connecting to a host, see the HostExplorer
Help.

1. Using HostExplorer, connect to a host.

2. On the Tools menu of the session window, point to Quick Script, and
click Edit.

The Quick Script Editor opens displaying a toolbar and menus specific to
HostExplorer Quick Scripts.

Note: If you want to start working with FTP Quick Scripts, you need to either open an existing one or
create one in Quick Script Editor.

To launch the Quick Script Editor from Hummingbird Neighborhood:

1. Launch Hummingbird Neighborhood by double-clicking on the
Hummingbird Neighborhood icon on your desktop.

2. On the Hummingbird menu, click Quick Scripts.

Related Topics
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Creating Quick Scripts




Creating Quick Scripts

The commands that are necessary to automate your task need to be
programmed in a script.

To create a Quick Script:

1.

On the File menu of Quick Script Editor, click New. Alternatively, you

can click the New button on the toolbar. The Quick Script Type dialog

box opens.

Note: The dialog box lists only supported Quick Script types. If only one script type is
available (for example, only 3270 HostExplorer Quick Scripts are supported because

you did not install HostExplorer 5250, HostExplorer VT, or FTP), then the dialog box
does not open.

Select a type for the new Quick Script and click OK. To create a
HostExplorer Quick Script, select 3270, 5250 or VT. To create an FTP
Quick Script, select FTP. A new Quick Script appears with the default
header line: Untitled: Description of Quick Script.

Double-click the header line so that you can insert text that describes
the new Quick Script that you are about to program. The Quick Script
Description dialog box opens.

Type a file name and description for the Quick Script and save it when
you are finished.



Inserting Quick Script Commands

Quick Script Editor provides HostExplorer and FTP Quick Script
commands that you can insert into your Quick Script.

To insert a Quick Script command, do one of the following:

Tip: For a list of the available HostExplorer and FTP Quick Script
commands, see Commands Menu.

. On the Commands menu, click the command item.

. Right-click a statement, point to Commands, and then click the
command item.

. Click the command button on the toolbar.

Any of these preceding actions (except for the Connect, Disconnect, and
Stop Quick Script commands) launches the corresponding dialog box in
which you can specify parameters for the Quick Script command.

Related Topics
Madifying Quick Scripts
Quick Script Type
Quick Script Description
Commands Menu




Modifying Quick Scripts

At any time, you can modify the Quick Script name and description. You
can also change the parameters of the commands within the Quick
Script, or move a command from one place to another within the Quick
Script.

To edit the header line of a Quick Script:

1. Open the Quick Script Description dialog box by doing one of the
following:

. Double-click the header line.
. Right-click the header line and click Properties.

2. Modify the file name and description of the Quick Script.
3. Click OK.

To edit the properties of a Quick Script command:

1. Open the dialog box corresponding to the command statement by
doing one of the following:

. Double-click the command line.
. Right-click the command line and click Properties.

2. Modify the properties as required.
3. Click OK.

To move commands within a script:

1. In the Quick Script, select the command statement that you want to
move.

2. Right-click the command line and select Move Up or Move Down from
the context menu. Alternatively, you can click the Move Up or the
Move Down button on the toolbar.

Related Topics
Creating Quick Scripts




Quick Script Description
Edit Menu




Saving Quick Scripts

After you are finished creating or modifying the Quick Script, you need to
save it so that it can be executed later.

To save a Quick Script:

1.

Create a Quick Script using Quick Script Editor.

2. Insert the necessary commands.
3.
4. In the Save In list, navigate to the directory in which you want to save

On the File menu, click Save As. The Save As dialog box opens.

the Quick Script. By default, the file is saved in the
Accessories\QuickScript folder where your user files are stored
on your machine.

In the File Name box, type a nhame for the new Quick Script. The file
name extension corresponds to the type of Quick Script that you
selected when you created it. For example, if you selected a 5250
Quick Script, the file will be saved with a . qs5 extension.

Note: You can also convert the Quick Script into a macro by selecting Macro Files (*.ebs)

in the Save As Type list in the Save As dialog box. You can then open and modify
the macro in Hummingbird Basic Workbench, or run the macro in HostExplorer.

Related Topics
Creating Quick Scripts

Modifying Quick Scripts

Running Quick Scripts




Running Quick Scripts

After programming your Quick Script using Quick Script Editor, you can
execute it.

To run a HostExplorer Quick Script:

1. In the host session window, on the Tools menu, point to Quick Script
and click Run. The Browse Quick Script Files dialog box opens.

2. Select a Quick Script and click Open. The selected Quick Script runs.

To run an FTP Quick Script:
1. In Quick Script Editor, open the Quick Script that you want to execute.

2. On the Commands menu, click Execute Quick Script. The selected
Quick Script runs.

Note: To stop the execution of the Quick Script at any time, click the Stop button on the
toolbar.

You also have the option of executing an FTP Quick Script file by passing
the file as an argument to Quick Script Editor and adding an “/EXEC"”

flag to the command line.

Related Topics

Creating Quick Scripts

Madifying Quick Scripts

Converting Quick Scripts to Macros




Converting Quick Scripts to Macros

In order for your Quick Script to be functional as a macro, you can
convert it by saving it as an . ebs file. Rather than creating the script in
Hummingbird Basic, you can use Quick Script Editor to create the file.
After you convert the file in Quick Script Editor, you can open and modify
the macro in Hummingbird Basic Workbench (if necessary), and run it in
the same way as any other HostExplorer macro.

Tip: For information on Hummingbird Basic Workbench, refer to the
Hummingbird Basic Workbench Help.

To convert your Quick Script to a macro file:

1.

Create a Quick Script file using the Quick Script Editor. If you are
using HostExplorer, you can create a Quick Script by recording your
actions (commands) in the host session window.

Note: If you record your Quick Script in HostExplorer, you need to first save it as a Quick
Script file, and then open it in Quick Script Editor.

On the Quick Script Editor File menu, click Save As. The Save As
dialog box opens.

In the Save As Type list, select Macro Files [*.ebs]. Alternatively, you
can add the . ebs extension to the name of the file in the File Name
box.

In the File Name box, type a name for the macro file.
Click Save.

Note: This action saves the Quick Script contents only as a macro file, not a Quick Script
file.

If you need to modify the macro, launch Hummingbird Basic
Workbench by performing one of the following actions:

. On the Tools menu of the HostExplorer session window, point to
Macro, and click Edit.

. On the Windows Start menu, navigate to the Hummingbird
Connectivity/Accessories program group, and click Hummingbird
Basic.



7. On the File menu, click Open.

8. Navigate to the folder where you stored the converted macro file, and
click Open.

9. Modify the macro (if necessary), and execute it.

Related Topics

Creating Quick Scripts

Running Quick Scripts
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Working with HostExplorer Quick Scripts

Quick Script Editor is a tool designed to automate repetitive or tedious
tasks. It has the following functions and capabilities:

. declares variables

. Creates labels

. controls execution flow of Quick Script commands

. shows Quick Script details

. Creates pop-up messages

For example, you can:

. Modify time-outs and delays to account for slower connections.

. Remove Send Keystrokes containing private information (for
example, passwords) and replace with a command that generates
a prompt dialog box.

Using the Quick Script Recorder, you can record keystrokes, hotspot
clicking, and other session events directly in the host session window.
You can also record a Quick Script at startup to include operations that
occur prior to a connection.

Sample files of 3270 Quick Scripts are available in the
Accessories\QuickScript directory where your user files are stored on
your machine.

Related Topics

Introducing Quick Scripts

Quick Script Editor Menu Descriptions (HostExplorer)
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Working with FTP Quick Scripts

Rather than create FTP scripts (.ebs files) based on the Hummingbird
Basic programming language, you can use the Quick Script Editor which
provides a graphical environment in which to create and modify FTP
scripts. As well, the commands are easier to manipulate in Quick Script
Editor.

Using Quick Script Editor, you can:

. transfer files and directory trees

. Create pop-up messages

. print files

. change transfer modes

. control execution flow of Quick Script commands

Related Topics
Introducing Quick Scripts
Quick Script Editor Menu Descriptions (FTP)




General Accessibility

Hummingbird products are accessible to all users. Wherever possible,
our software adheres to Microsoft Windows interface standards and
contains a comprehensive set of accessibility features.

Access Keys All menus have associated access keys (mnemonics) that
let you use the keyboard, rather than a mouse, to navigate the user
interface (Ul). These access keys appear as underlined letters in the
names of most Ul items. (If this is not the case, press Alt to reveal them.)
To open any menu, press Alt and then press the key that corresponds
with the underlined letter in the menu name. For example, to access the
File menu in any Hummingbird application, press Alt+F.

Once you have opened a menu, you can access an item on the menu by
pressing the underlined letter in the menu item name, or you can use the
arrow keys to navigate the menu list.

Keyboard Shortcuts Some often-used menu options also have shortcut
(accelerator) keys. The shortcut key for an item appears beside it on the
menu.

Directional Arrows Use the directional arrows on the keyboard to
navigate through menu items or to scroll vertically and horizontally. You
can also use the directional arrows to navigate through multiple options.
For example, if you have a series of radio buttons, you can use the arrow
keys to navigate the possible selections.

Tab Key Sequence To navigate through a dialog box, press the Tab key.
Selected items appear with a dotted border. You can also press Shift+Tab
to go back to a previous selection within the dialog box.

Spacebar Press the Spacebar to select or clear check boxes, or to
select buttons in a dialog box.

Esc Press the Esc key to close a dialog box without implementing any
new settings.

Enter Press the Enter key to select the highlighted item or to close a
dialog box and apply the new settings. You can also press the Enter key
to close all About boxes.



ToolTips ToolTips appear for all functional icons. This feature lets users
use Screen Reviewers to make interface information available through
synthesized speech or through a refreshable Braille display.



Microsoft Accessibility Options

Microsoft Windows environments contain accessibility options that let you
change how you interact with the software. These options can add
sound, increase the magnification, and create sticky keys.

To enablel/disable Accessibility options:
1. In Control Panel, double-click Accessibility Options.

2. In the Accessibility Options dialog box, select or clear the option
check boxes on the various tabs as required, and click Apply.

3. Click OK.

If you installed the Microsoft Accessibility components for your Windows
system, you can find additional accessibility tools under Accessibility on

the Start menu.



Technical Support

You can contact the Hummingbird Technical Support department Monday
to Friday between 8:00 a.m. and 8:00 p.m. Eastern Time.

Hummingbird Ltd.
1 Sparks Avenue, Toronto, Ontario, Canada M2H 2W1

Canada and the USA || International

Technical Support: || 1-800-486-0095 +1-416-496-2200

General Enquiry: || 1-877-FLY-HUMM +1-416-496-2200

Main: || +1-416-496-2200

Fax: || +1-416-496-2207

E-mail: || support@hummingbird.com

FTP: || ftp.hummingbird.com

Web Support: || support.hummingbird.com/customer

Web Site: || www . hummingbird.com
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Commands Menu

The items in the Commands menu vary depending on whether you are
working with HostExplorer or FTP Quick Scripts.

HostExplorer Quick Script Commands || FTP Quick Script Commands

Label

Label

Go To Label

Go To Label

Pop Up Message

Pop Up Message

Connect

Connect to Host

Disconnect

Disconnect

Set Cursor Position

Rename Host File

Send Keystrokes

Print Host File

Wait For Input

Create Host Directory

Wait For Text

Change Host Directory

Declare Variable

Delete Host File

Compare Variables

Delete Host Directory

Prompt For Value

Delete Host Tree

Read Screen into Variable

Local Directory

Send Variable To Screen

File Transfer Type

Pause

Get File

Execute Quick Script

Get Multiple Files

Stop Quick Script Get Tree
Run Application Put File

Copy Selection

Put Multiple Files

Paste To Cursor Position

|| Put Tree




Pause

Execute Quick Script

Stop Quick Script

Related Topics
Creating Quick Scripts




Quick Script Type

To access

This dialog box lets you select a type for the Quick Script that you are
about to create.

Select Quick Script Type—Select a type depending on whether you
want to create a HostExplorer or FTP Quick Script. To create a
HostExplorer Quick Script, select 3270, 5250 or VT. To create an FTP
Quick Script, select FTP.

Related Topics
Creating Quick Scripts
File Menu
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Quick Script Description

To access

Using this dialog box, you can modify the file name and description of the
new Quick Script.

File Name—Type a name for the Quick Script file.

Description—Type a description that you can use to identify the Quick
Script.

Related Topics
Creating Quick Scripts
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Edit Menu

The Edit menu contains the following options:
Undo—Cancels the previous action.
Redo—Duplicates the previously undone action.

Cut—Removes the selection and saves it to the local Quick Script Editor
clipboard and enables the Paste command.

Copy—Copies the selection to the local Quick Script Editor clipboard and
enables the Paste command.

Paste—Pastes local Quick Script Editor clipboard contents after the
currently selected statement.

Move Up—Moves the selected command or statement up one line in the
Quick Script.

Move Down—Moves the selected command or statement down one line
in the Quick Script.

Delete—Removes the selected command or statement.

Properties—Opens the Quick Script Description dialog box, which lets
you provide a name and description for the local Quick Script Editor
clipboard contents.

Related Topics
Modifying Quick Scripts




Quick Script Editor Menu Descriptions
(HostExplorer)

To view menu descriptions, click one of the following links:
File Menu
Edit Menu

Commands Menu

View Menu

Help Menu



Append File

To access

The Append File command lets you specify a file on your PC, and attach
it to a file on the remote host.

Source File—Specifies the full source path and name of the PC file you
want to append to the remote host file.

Destination—Specifies the full destination path and name of the host file
to which you want to append the PC file. If you do not provide a
destination, the script sends the file to the current working directory of the
host.

On Error, Goto—Specifies the label to which the script should go if it
encounters an error. Select Resume Next if you want the script to
continue with the next command instead.

Related Topics
Commands Menu
Rename Host File
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Quick Script Editor Menu Descriptions (FTP)

Click one of the following links to view menu descriptions.
File Menu
Edit Menu

Commands Menu

View Menu

Playback Menu
Help Menu




Label

To access

The Label dialog box lets you create a label. You can use labels to
branch or direct the flow of execution, as well as create loop structures or
code blocks.

Label Name—Type characters, symbols, or numbers.

Related Topics
Go To Label
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Go To Label

To access

The Go To Label dialog box lets you direct execution to the specified
label.

Label—Select a previously defined label from the drop-down list.

Related Topics
Set Cursor Position
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Pop Up Message
To access
The Pop Up Message dialog box lets you open a message dialog box.

Title—Type the appropriate title for the dialog box.
Message—Type a message.

Related Topics
Commands Menu
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Connect

To access

This command inserts a Connect statement, which causes HostExplorer
to connect to the host.

Related Topics
Disconnect
Connect to Host
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Connect to Host

To access

The Connect To Host command lets you set the parameters that will be
used to connect to the specified host.
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Server Information

Lets you specify the general properties of the server to which you want to
connect.

Server Name—Specifies the name or IP address of the host.
User Name—Specifies your login user ID.
Account—Specifies your login account, if necessary.

System Type—Specifies the type of host to which you will be connecting
(for example, UNIX and Hummingbird FTP Daemon). By default, Auto
Detect is selected.

Server Port—Specifies the host port or socket number to be used for the
FTP session. By default, this option is set to 21.

Password—Specifies your login password.

Initial Directory—Specifies the path of the startup directory when you
are connected to the host.



Connection Settings
Lets you configure the connection to the specified host.

PASV Mode—This check box is available only when the Use SSH check
box is cleared. Select this check box if you want to use Passive FTP
mode, which ensures that Hummingbird FTP handles all data flow
initiation, rather than the FTP server.

Reply Timeout—Specifies the amount of time (in seconds) that
Hummingbird FTP will wait for a reply from the FTP server before
disconnecting. By default, this option is set to 2 minutes (120 seconds).

Security—Select the type of security (for example, Secure Shell) that
you want to use for the connection.

Configure—Opens the GSSAPI dialog box or the SFTP dialog box,
where you specify security settings.



Firewall Settings
Lets you specify a firewall to use for the connection.

Firewall Type—Select the type of firewall (for example, Proxy connect)
that you want to use to protect your private network resources.

Firewall Server Name—Specifies the address of the FTP firewall server
you want to use for the host connection.

User Name—Specifies the user ID on the firewall server.

Firewall Port—Specifies the port number on which the firewall is
listening. By default, this option is set to 21.

Password—Specifies the password on the firewall server.



On Error, Goto

Lets you specifies the label to which the script should go if it encounters
an error. Select Resume Next if you want the script to continue with the
next command instead.

Related Topics
Quick Script Editor Menu Descriptions (FTP)
Commands Menu




Disconnect

To access

This command inserts a Disconnect statement which causes
HostExplorer or Hummingbird FTP to disconnect from the host.

Related Topics
Connect
Connect to Host
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Set Cursor Position

To access

The Set Cursor Position dialog box lets you set the cursor position, and is
available in TN3270 and TN5250 host windows.

Row—~Position in the host window. For example, 1 is the upper-most row.

Column—~Position in the host window. For example, 1 is the left-most
column.

Related Topics
Paste To Cursor Position
Connect to Host
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Rename Host File

To access

The Rename Host File command lets you rename a file that has been
transferred to or from the host. For example, if you want to maintain a
certain naming convention for host files, then you can rename a specific
file once it gets uploaded to the host.

Source Path—Specifies the path to the file you want to rename.

Destination Path—Specifies the location where you want the renamed
file to be stored.

Note: The relocation of the renamed file is dependent on whether or not your host supports this
functionality.

On Error, Goto—Specifies the label to which the script should go if it
encounters an error. Select Resume Next if you want the script to
continue with the next command instead.

Related Topics
Append File
Commands Menu
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Send Keystrokes

To access

The Send Keystrokes dialog box provides a text box for typing keystrokes
and inserting mnemonics (according to category). Contents of the text
box are sent to the host when the statement is executed. The Send
Keystrokes statement is often followed by one of the following
commands:

. Wait For Input

. Wait for Text

Keystrokes—Type keystrokes and enter mnemonics.
Category—Select a group of keys.

Mnemonic—Select the appropriate representative word from the drop-
down list. The list varies according to the Category selection.

Insert—Appends the word or string (representing the particular
mnemonic) in the Keystrokes box.

Related Topics
Connect to Host
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Print Host File

To access
The Print Host File command lets you print a file that resides on the host.
File Path—Specifies the full path of the file you want to print.

On Error, Goto—Specifies the label to which the script should go if it
encounters an error. Select Resume Next if you want the script to
continue with the next command instead.

Related Topics
Append File
Rename Host File
Commands Menu
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Wait For Input

To access

The Wait For Input dialog box lets you instruct the Quick Script to wait for
a specified amount of time until the host is ready to allow keyboard input.
If input is allowed within the specified time, the true branch is executed. If
not, the false branch is executed. The Wait For Input command is often
preceded by the Send Keystrokes statement.

Timeout (seconds)—Time in seconds to wait for input. If the host is
ready before this time expires, the If Ready command or action is
performed. If the host is not ready, the Otherwise command or action is
performed.

Settle Time (seconds)—Time in seconds beyond the timeout to verify
whether the host is still ready. This is necessary because certain hosts
allow input and then quickly disallow input again. If the host is not ready
after the settle time, the Wait For Input statement fails.

If Ready—Directs execution to the statement or command (from the
drop-down list) if the host is still ready.

Otherwise—Directs execution to the statement or command (from the
drop-down list) if the host is not ready.

Properties—Specifies settings for the selected statement. There are no
properties for commands such as Do Nothing, Connect, Disconnect, and
Terminate Quick Script Execution. The button is not enabled for the Go
To Label and Compare Variables commands, if (respectively) a label is
not yet defined or a variable is not yet declared.

Related Topics
Wait For Text
Send Keystrokes
Connect to Host
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Create Host Directory

To access

The Create Host Directory command lets you create a host directory that
you can use to store your transferred files.

Directory Path—Specifies the full path of the directory you want to
create.

On Error, Goto—Specifies the label to which the script should go if it
encounters an error. Select Resume Next if you want the script to
continue with the next command instead.

Related Topics
Connect to Host
Append File
Commands Menu
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Wait For Text

To access

The Wait For Text dialog box lets you instruct the Quick Script to wait for
specified text to appear at the specific location on the screen within the
allotted amount of time. If successful, the true branch of the statement is
executed. If unsuccessful, the false branch is executed.

Text—Specifies the text for which the Quick Script is to wait.
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Position

Anywhere—Looks for text anywhere in the host window and
disables Row and Column boxes.

Row—Position in the host window. For example, 1 is the upper-
most row.

Column—~Paosition in the host window. For example, 1 is the left-
most column.



Options

Timeout (secs)—Time (in seconds) to wait for text. If the text is
found before this time expires, the “If found” command or action is
performed. If the text is not found after the timeout, the Otherwise
command or action is performed.

Settle Time (secs)—Time (in seconds) beyond the timeout to
verify if the text is still available to the host screen. This is
necessary because certain hosts allow input and then quickly
disallow input again. If the host is not ready after the settle time,
the Wait For Input statement fails.

Wait for Input—If enabled, the macro waits for the host to allow
user input after the text is found at the specified location. If you
clear this check box, then user input is not processed.

Case Sensitive—If enabled, the macro looks in the host window
for the specific case used in the Text box. Case is ignored if you
clear this check box.

If Found—Directs execution to the statement or command (from the
drop-down list) if input is received before the timeout and settle time
expire.

Otherwise—Directs execution to the statement or command (from the
drop-down list), if the text is still not found after the timeout and settle
time expire.

Properties— Specifies settings for the selected statement. There are no
properties for commands such as Do Nothing, Connect, Disconnect, and
Terminate Quick Script Execution. The button is not enabled for the Go
To Label and Compare Variables commands, if (respectively) a label is
not yet defined or a variable is not yet declared.

Related Topics



Wait For Input
Connect to Host




Change Host Directory

To access

The Change Host Directory command lets you change from the current
directory to another directory on the host to which you want to transfer
files.

New Path—Specifies the path of the directory to which you want to
change.

On Error, Goto—Specifies the label to which the script should go if it
encounters an error. Select Resume Next if you want the script to
continue with the next command instead.

Related Topics
Create Host Directory
Delete Host Directory
Commands Menu
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Declare Variable

To access

The Declare Variable dialog box lets you define (declare) a variable that
is used by the following commands:

. Compare Variables

. Prompt For Value

. Read Screen Into Variable

. Send Variable To Screen

Variable Name—Type a unique name. You can type alphanumeric
characters or symbols.

Initial Value—Type a value.

Related Topics
Working with HostExplorer Quick Scripts
Connect to Host
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Delete Host File

To access

The Delete Host File command lets you delete a file from the host. For

example, after you download a file, you can automatically remove it from
the host.

File Path—Specifies the path of the host file you want to delete.

On Error, Goto—Specifies the label to which the script should go if it
encounters an error. Select Resume Next if you want the script to
continue with the next command instead.

Related Topics
Rename Host File
Delete Host Directory
Commands Menu
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Compare Variables

To access

The Compare Variables dialog box lets you compare the value of one
variable with that of another. Variables must already be declared. If the
values are equal, the true part of the condition is executed, otherwise, the
false part is executed.

You can specify in the dialog box what action is performed:

Variable A—Select a previously declared variable from the drop-down
list. The first variable in the Quick Script is selected by default.

Function—Select a function (for example, “equals”) from the drop-down
list or type a value. For an empty string, select NULL from the drop-down
list.

Variable B—Select a previously declared variable from the drop-down
list. The second variable in the Quick Script is selected by default.

If True—Directs execution to the statement or command (from the drop-
down list) where the If and Equals fields are the same.

Otherwise—Directs execution to the statement or command (from the
drop-down list) where the If and Equals fields are not the same.

Properties—Specifies settings for the selected statement. There are no
properties for commands such as Do Nothing, Connect, Disconnect, and
Exit Macro. This button is enabled for Go To Label or Compare Variable
statements if (respectively) a label is not yet defined or a variable is not
yet declared.

Related Topics

Declare Variable

Send Variable To Screen
Prompt For Value
Connect to Host
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Delete Host Directory

To access

The Delete Host Directory command lets you remove a directory from the
host. For example, after you download all the files from a specific
directory on the host, you can remove the entire directory from the host.

Directory Path—Specifies the path of the directory you want to delete.

On Error, Goto—Specifies the label to which the script should go if it
encounters an error. Select Resume Next if you want the script to
continue with the next command instead.

Related Topics
Create Host Directory
Append File
Commands Menu
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Prompt For Value

To access

This dialog box lets you insert a command that prompts for information
and stores the input into a previously declared variable.

Dialog Title—Type the appropriate title.
Prompt Text—Type a message.
Variable—Select a previously declared variable.

Hide Input—Displays asterisks in place of the input information. Useful
for prompting for passwords.

Related Topics
Connect to Host
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Delete Host Tree

To access

The Delete Host Tree dialog box lets you delete an entire directory tree
structure from the host. For example, after you have downloaded a
directory tree structure to your PC, you can remove the tree from the
host.

Tree Root Path—Specifies the root path to the tree you want to delete.

On Error, Goto—Specifies the label to which the script should go if it
encounters an error. Select Resume Next if you want the script to
continue with the next command instead.

Related Topics
Get Tree

Put Tree
Commands Menu
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Read Screen into Variable

To access

The Read Screen into Variable dialog box lets you insert a command that
reads the contents of the specified location into the previously declared
variable. This is useful if the variable is compared later and branched
according to the result.

Variable—Select a previously declared variable from the drop-down list.
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Start Position
Row—Type a number representing the row position.
Column—Type a number representing the column position.

Length—Type the number of character positions in the specified row
following (and including) the column position.

Note: The Length option takes precedence over the Read Only One Word option.

Read Only One Word—Read all characters up to the first space.

Related Topics
Declare Variable
Quick Script Editor Menu Descriptions (HostExplorer)
Connect to Host




Local Directory

To access

The Local Directory command lets you specify the directory that will be
used to store files downloaded from the host.

Local Directory—Specifies the path to the directory on your PC that will
store files transferred from the host. Click Browse to locate the directory.

Related Topics
File Transfer Type
Get File
Commands Menu
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Send Variable To Screen

To access

The Send Variable To Screen dialog box lets you insert a command that
sends the contents of the previously declared variable to the host.

Variable Name—Select a previously declared variable from the drop-
down list.

Related Topics
Declare Variable
Read Screen into Variable
Connect to Host
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File Transfer Type

To access

The Transfer Type command lets you set the file transfer type to suit the
type of file being transferred to or from the host.
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Transfer Type
Select one of the following:

Auto—The transfer type automatically changes to suit the file. This is the
default setting.

Binary—Suitable for transferring executable and other binary files.

ASCII—Suitable for transferring text files

Related Topics
Local Directory
Get File
Commands Menu




Pause

To access

The Pause dialog box lets you insert a command that causes the Quick
Script to pause a certain amount of time (in seconds) upon execution of
the previous statement.

Pause for—Type the time in seconds. The default is 2 seconds.

Related Topics
Commands Menu
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Get File

To access

The Get File command lets you retrieve a specific file from the host and
transfer it to a PC.

Source File—Specifies the full path to the file on the host.

Destination—Specifies a location for the file on the PC. If you do not
provide a destination, the script sends the file to the current working
directory.

On Error, Goto—Specifies the label to which the script should go if it
encounters an error. Select Resume Next if you want the script to
continue with the next command instead.

Related Topics
Local Directory
File Transfer Type
Commands Menu
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Execute Quick Script

To access

The Execute Quick Script command executes an existing Quick Script.
This is similar to a procedure call or method (or subroutine).

This command launches the Open dialog box. Use the command to
locate and select a Quick Script file. Click Open, and the statement is
inserted in Quick Script Editor. The selected Quick Script runs and the
script execution returns to the parent Quick Script when the specified
Quick Script ends.

Related Topics
Running Quick Scripts
Connect to Host
Commands Menu
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Get Multiple Files

To access

In cases where you need to retrieve more than one file at a time from the
host to the PC, you can use the Get Multiple Files dialog box.

Source Pattern—Specifies the pattern used by the host to get all
matching files. You can use the wildcard “*” to represent multiple
characters, and the wildcard “?” to represent a single character.

On Error, Goto—Specifies the label to which the script should go if it
encounters an error. Select Resume Next if you want the script to
continue with the next command instead.

Related Topics
Commands Menu
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Stop Quick Script

To access

This command inserts the Terminate Quick Script Execution statement
which stops the execution of the Quick Script.

Note: For HostExplorer Quick Scripts, you can also terminate the execution by pointing to Quick Script
on the Tools menu of the host session window, and clicking Stop. For FTP Quick Scripts, you
can also terminate the execution by clicking Stop on the Playback menu (or clicking the Stop
button on the Playback toolbar).

Related Topics
Running Quick Scripts
Execute Quick Script
Commands Menu
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Get Tree

To access

The Get Tree dialog box lets you retrieve an entire directory tree structure
from the host to the PC.

Source Path—Specifies the full path of the directory tree on the host.

Destination—Specifies the full path to the location on the PC where you
want to put the directory tree. If you do not provide a destination, the
script uses the local default directory.

On Error, Goto—Specifies the label to which the script should go if it
encounters an error. Select Resume Next if you want the script to
continue with the next command instead.

Related Topics
Delete Host Tree
Put Tree
Commands Menu
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Run Application

To access

This command inserts the Run Application statement, which runs an
executable file.

Application—Specify the path to the executable file you want to run, or
browse to its location.

Parameters—Specify the parameters of the executable file.

Minimize Application Window—Select to minimize the application
window.

Minimize HostExplorer Window—Select to minimize the HostExplorer
window.

Related Topics
Creating Quick Scripts
Connect to Host



javascript:QuickScriptDialogs76.Click();

Put File

To access

The Put File dialog box lets you transfer a single file from the PC to the
host.

Source File—Specifies the full path and name of the PC file you want to
send to the remote host.

Destination—Specifies the full path to the location on the host where
you want to send the file. If you do not provide a destination, the script
sends the file to the current working directory of the host.

On Error, Goto—Specifies the label to which the script should go if it
encounters an error. Select Resume Next if you want the script to
continue with the next command instead.

Related Topics
Commands Menu
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Copy Selection

To access

This command inserts the Copy Selection to Clipboard command, which
copies the coordinates of an area that you specify in the Copy Selection
dialog box.

Selection Start—Enter the location coordinates of the start of the area
you want to select.

Selection End—Enter the location coordinates of the end of the area you
want to select.

Select All—Select this box to specify the entire area.

Related Topics
Paste To Cursor Position
Connect to Host
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Put Multiple Files

To access

In cases where you need to send more than one file at a time from your
PC to the host, you can use the Put Multiple Files dialog box.

Source Pattern—Specifies the pattern used to send all matching files to
the host. You can use the wildcard “*” to represent multiple characters,
and the wildcard “?” to represent a single character.

On Error, Goto—Specifies the label to which the script should go if it
encounters an error. Select Resume Next if you want the script to
continue with the next command instead.

Related Topics
Commands Menu
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Paste To Cursor Position

To access

This command inserts the Paste To Cursor Position command, which
pastes the contents of the clipboard to the coordinates that you specify in
the Paste To dialog box.

Row—Enter the row coordinate.
Column—Enter the column coordinate.

Cursor Position—Select to specify the coordinates of the cursor
position.

Related Topics
Set Cursor Position
Copy Selection
Connect to Host
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Put Tree

To access

The Put Tree dialog box lets you transfer an entire directory tree from the
PC to the host.

Source Path—Specifies the PC directory that you want to send to the
host.

Destination—Specifies the full path to the location on the host where
you want to send the directory tree. If you do not provide a destination,
the script uses the local default directory.

On Error, Goto—Specifies the label to which the script should go if it
encounters an error. Select Resume Next if you want the script to
continue with the next command instead.

Related Topics
Get Tree

Delete Host Tree
Commands Menu
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File Menu

The File menu contains the following options:
New—Opens the Quick Script Type dialog box.

Open—Launches the Open dialog box, which you can use to locate and
select a Quick Script file.

Save—Saves the file as a HostExplorer Quick Script file (.gs3, .gs5, .qsv
depending on the terminal type) or an FTP Quick Script file (.qsf) with the
specified file name.

Save As—Saves the file as a HostExplorer Quick Script file (.qs3, .gs5,
.gsv depending on the terminal type) or an FTP Quick Script file (.gsf)
with the specified file name (default) or a new file name. You can convert
the Quick Script file to a HostExplorer macro file by selecting Macro Files
[*.ebs] in the Save As Type list.

Print—Opens the Print dialog box, which you can use to print the
commands and statements displayed in the Quick Script Editor window.

Recent File—Opens the recently saved Quick Script file.
Exit—Closes the Quick Script Editor.

Related Topics
Quick Script Type
Creating Quick Scripts




View Menu

The View menu consists of the following options:

Standard Toolbar—Toggles the display of the standard Windows
toolbar.

Commands Toolbar—Toggles the display of the toolbar in the Quick
Script Editor.

Playback Toolbar (FTP Quick Scripts only)—Toggles the display of the
Playback toolbar which consists of the Playback, Step, and Stop buttons.

Collapse All—Toggles the display of the Quick Script in which nested
Quick Script commands collapse into one line.

Status Bar—Toggles the display of the status bar at the bottom of the
Quick Script Editor.

Related Topics
File Menu
Commands Menu

Help Menu




Help Menu

You can use the Help menu to access the version of Quick Script Editor.
The Help menu contains the following options:

Contents—Opens the Quick Script Editor help which contains
information on how to use Quick Script Editor.

About—Shows version information about the installed Quick Script
Editor product.

Related Topics
File Menu
Commands Menu
View Menu




Playback Menu

The Playback menu is available only for FTP Quick Scripts. The menu
consists of the following options:

Stop—Terminates the execution of the Quick Script.
Start—Starts the execution of the Quick Script.

Step—Executes the Quick Script commands one at a time, starting from
the beginning of the Quick Script. This is useful if an executed script fails,
and you want to narrow down the exact point of failure.

Related Topics
Running Quick Scripts
Quick Script Editor Menu Descriptions (FTP)




